




In the blink of an eye, school’s 
returning and it’s just round the 
corner! While some may welcome 
it and some dread, what matters 
most is to ensure you have 
enjoyed yourselves, relax and is 
ready for the new term!

Although the holidays may have 
ended, fret not as the Great 

Singapore Sale is still on! @
iKnow brings you the latest and 
greatest deals in the market. 
Check out the Budget Calculator 
and Products Feature for details. 
Don’t miss the last chance before 
the discounts ends!

And that’s not the end of the 
surprises we have in store for you 

yet. @iKnow is also giving out 
free movie tickets, book vouchers 
and the collectible cards of the 
latest game - Animal Kaiser.

With so much good news and 
freebies, let’s welcome the new 
semester with the brightest mood 
@iKnow!
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45 years ago, the first series of 
racial riots claimed 36 lives and 
injured 556. A further 3,000 were 

imprisoned as a result. Half a decade 
later, another similar outburst left 4 
dead and 80 wounded. 

Our younger generation have been 
spared the horrors of the yesteryears, 
and may never fully understand what 

it was like. 
However, in 
order to prevent 
such tragedies 
from happening 
again, Singapore’s 
young ones must 
first know the 
catalysts that 
ignited violence 
and learn from 
our forefathers’ 
mistakes. 

The government 
and schools 
are not the only parties responsible 
for inculcating correct values in our 
children. Putting up Racial Harmony 
posters on the streets and in schools, 
running Racial Harmony celebrations and 
television programmes all go a long way 
in reinforcing the importance of Racial 

By Andy Goh & Christine Yee
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“I have a dream that my four 
little children will one day live 
in a nation where they will not 
be judged by the colour of their 
skin but by the content of their 
character.
I have a dream today.”
~ Martin Luther King, Jr. (1929 – 1968)
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Harmony. It is also vital for educators 
to create opportunities for children to 
get a better understanding of other 
cultures and teach them to be culturally 
sensitive.

At home, parents also share the 
responsibility of instilling positive 
values in their children. It should not 
be just plain talk and lecture, but 
physically being a role model for the 
young ones to emulate, for children are 
often best at following what they see.

For example, when giving up seats to 
the needy, have parents themselves 
made the mistake of only showing 
courtesy and care towards people of 
the same race and ignoring the others? 
Have parents unknowingly made unkind 
comments on citizens of other races, 
especially during festive periods when 
patience becomes strained?

In general, parents should never have 
the “I’ll only educate my child” mindset.  
Adults should step in when they witness 

a child displaying racial discrimination 
towards another, even if the child is 
not theirs. It is never too early to 
educate, but it will be too late if no one 
does anything and the child goes away 
thinking it is alright. 

This issue, @iKnow celebrates Racial 
Harmony, and is delighted to have 
received many meaningful entries on 
Racial Harmony from students and 
teachers (see page 9 - 13).

In short, looking at our multi-racial 
society where harmony amongst citizens 
plays a paramount role in maintaining 
peace and stability, it is crucial that 
everyone of us play our part to build a 
racially harmonious nation together!
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A quick look at dark chocolate’s 
profile:

Dark chocolate prevents:
- Inflammation of blood vessels;
- Stroke and heart attacks by clearing free 

radicals from arterial wall lining, and  
- Cancer due to the rich content in a 

powerful oxidant called Catechins

Dark chocolate is:
- Filling, thus removing the craving for 

sweet, salty and fatty food
- Able to lower blood pressure and 

balances hormones
- Lowers LDL (the bad cholesterol) 
- A form of anti depressant
- Contains higher oxidant count than 

green tea
- Not as sweet as normal milk chocolate

A chocolate a day keeps illness away; 
and never before has there been a 
sweeter tune to children’s ears! 

It used to be the apples keeping the doctor 
at bay but now comes a better option: 
chocolate or more precisely dark chocolate.

Do you know that contrary to housewives 
tales of how candies are bad for teeth and 
make children fat, dark chocolate actually 
does the opposite and reaps you more 
benefits?

Besides, Tudor Gold comes packed with 
fantastic tasting fruits and nuts, almond, all 
within a healthy bar! 

Available at selected NTUC FairPrice 
supermarkets at a very affordable price, Tudor 
Gold Dark Chocolate bar is the wisest choice. 
So, what are you waiting for? Hurry down to 
the NTUC FairPrice supermarket to get a taste 
of it yourself!

Profile
Name: Tudor Gold
Availability: Selected NTUC FairPrice 
                       Supermarkets
Price: $2.95 only
Highlight: Dark chocolate bar with 55% 
                    cocoa content



Have you ever wondered about a battle between 
the Eagle and Shark? What the world will 
be like if animals from land, sea and sky can 
interact with and challenge one another?

In recognition of Singapore’s famous 
Night Safari and Zoo, the Animal 
Kaiser has chosen Singapore to be 

the very first country to launch its Animal 
Kaiser game cards from Japan! This card 
collecting game will stretch your dreams 
and imaginations to their wildest and 
summon the animal kingdom into battle. 

@iKnow is proud to be one of the first 
local media to conduct an exclusive 
interview with Akihiko Arai, the producer 
of Animal Kaiser. 

1. What is the highlight of the game?
It has to be the factor of the unknown 
powers waiting to be discovered with 
every card! The most attractive power 

is the “Miracles” from the Miracles 
Card. There are also universal attacking 
methods such as causing natural disasters 
or throwing the moon at your enemies.  
There are much more fantastic miracles 
and powers waiting for the players!  

2. Animal Kaiser is one of the most 
popular cards collecting game in Japan. 
What makes people so crazy after it?
In this game, even the weaker animals can 
achieve strong powers. There are just 
too many ways to combine the cards. Card 
customising seems simple, but there are 
various special features within each card. 
The realistic animals’ illustrations and 
the beautiful design of the cards are also 
reasons why it is so popular in Japan.

By Christine Yee

Profile
Name: Animal Kaiser
Developer: Bandai Namco Games
Local distributor: IAHGames
Availability: Selected 7-Eleven and iEcon 
              Minimarts

Profile
Name: Animal Kaiser
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              Minimarts
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Born in Kenya, Africa, Leo is a brave young lion. He went 
on a journey to find his missing father. In the midst of his 
journey he met many dangerous creatures. In defeating 
them, Leon became hungry to be the strongest animal in 
the world. 

3. One of the interesting points is 
players get to combine different cards to 
create their own super-animal. Can you 
share some of the strategies?
Users can enhance the killing techniques to 
a very high level by employing a combination 
of cards, particularly the Green strong 
card, and then form the ultimate secret 
technique! The use of the ultimate secret 
technique will severely damage the 
opponent’s animal, regardless of what animal 
he has.  

Unleash your creativity and create your own 
super animal!

Animal Cards
Brings an animal into the battle field
Each animal has three unique attack 
opportunities

Strong Cards
Raises the power of the animal’s attacks
The card’s strength is shown in five levels

Miracle Cards
Channels the power of nature to strike 
the enemy

75 Animal Kaiser’s 
cards to be won.
Tell us your favourite animal! 
Simply email to:

magazine@iknow.com.sg
(Subject: Animal Kaiser) 
Submit your full name, NRIC no., school name (if any), 
contact no. and mailing address. 
Good luck! 
Closing Date: 2/8/09
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Dear Kozomiku,
A good friendship is hard to come by and you may want to put yourself in your friend’s shoes before coming to any conclusion.

Here are some questions for thought.Would it be possible that she feels really excited and special when her father surprised her with a treat and automatically assumes that her good friends would understand that she feels bad turning her father down? Would it be possible for her to combine her celebration with her dad and friends? 

How would you respond if faced with the same situation?
Most friendships break down due to the lack of communication. Tell her how you feel and seek her responses. A good friend accepts you for who you are. 

They are also patient with you when you make mistakes and forgive you when you hurt them. 

A good and open communication is necessary with those we value as friends. When you converse with others, you show personal interest in their feelings, and you encourage them to express their thoughts and emotions. Good communication requires one to be a good listener – so do stop and listen to what your friends have to say.

Miss Has

Kozomiku writes

I’m freaking angry with an old friend of mine. She asked me and 3 of our 
friends out to celebrate her birthday. To surprise her, we prepared a party 
for her with presents and a cake. We told her to come at 8.30pm while the 
rest of us arrived much earlier to ensure everything is OK - the presents, the 
cake and food. At a quarter past 8, she texted me “Hey, my father is treating 
me. A surprise treat. Can I change to meet u all tmr? Same time, same venue?” 
She stood us up last minute, expecting that we will be free tomorrow. I don’t 
think I wish to be her friend anymore.

Share your thoughts with 
Miss Has. Write in to 
magazine@iknow.com.sg
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The celebration of racial harmony in Singapore
Claire Lim Jia YiRed Swastika School(Coloured Pencil)

Racial Harmony

Cheryl Yeo
Red Swastika School
(Water Colour)

Racial Harmony Day
Chua Yang JieRed Swastika School

(Water Colour)

Four children,
multiple races,
different backgrounds, 
one nation.
Guo Li
Boon Lay Garden Primary School

(Inkscape Freeware)
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Racial harmony in Singapore
Megan CheahRed Swastika School(Crayon)

Respect, care and harmony 
regardless of race
Ng Shi Chian
Boon Lay Garden Primary School
(Inkscape Freeware)

Happy Racial Harmony
Shing YinRed Swastika School(Water Colour)

Hand-in-hand to establish 
a harmony and famous 
nation/ country
Song Zhi Qian
Red Swastika School
(Coloured Pencil)
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Students’ Corner is a section for students to express themselves and also to let budding 
writers practise their penning skills.

@iKnow magazine presents Theme of the Issue, where students may send in articles, 
writings, drawings or photographs, with respect to the said title.

Next Issue’s Theme: Celebrations
Email your submission(s) with your full name, school name and home address to
magazine@iknow.com.sg (Subject Head: Students’ Corner)

The five stones represents the five circles (of Olympic logo) - harmony and unity without racial or religious discriminations
Tan Xiao Hui ConstanceBoon Lay Garden Primary School(Inkscape Freeware)

Racial harmony brings 
world peace.

Tatum Cheah Xin Yu
Red Swastika School
(Crayon)

Together,we strive for Singapore
Sean WangRed Swastika School(Coloured Pencil)

iKnow 11



n the past decade, Singapore’s foreign population has increased very rapidly. 
With the influx of foreigners into Singapore, the ethnic composition is 
becoming more and more varied, making it even more crucial to maintain 

racial harmony. 

The meanings and purposes of celebrating racial harmony are numerous and the 
most important of them all is to maintain peace in our multi-racial and multi-
cultural society. @iKnow is honoured to invite teachers from four schools to share 
their thoughts on this topic.

“To me, Racial Harmony is not just about donning traditional clothes of another 
race and appreciating their traditional food. It is a time for us to ponder, 
appreciate and celebrate our success as a nation that enables us to live and work 
together as one harmonious society, built on tolerance and understanding of each 
other’s cultures and heritage.”
  

Mr. Hui Keen Lon Tony, Teacher, Pasir Ris Primary School

“Racial Harmony is especially vital in maintaining 
the social and cultural balance in a multi-
racial society like Singapore. Educators play an 
important role in guiding students to understand 
the differences between races and celebrate 
them. 
 
I also believe that students will learn racial 
harmony more effectively when there are 
more student-centered activities that involve 
collaborative projects. The use of new media can 
further create an engaging and authentic learning 
experience of racial harmony.” 

Mr. Kwan Tuck Soon, teacher, Rulang Primary School

By Christine Yee
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“To me, racial harmony is vital to the survival 
of Singapore. Being a small metropolitan 
nation with no natural resources, our most 
important resource is our people. We need 
to work together as a team to ensure the 
success of our country. If we are racially 
divided, not only will our lives be in jeopardy, 
Singapore will also not be able to progress 
to what it is today. Therefore, maintaining 
social cohesion and racial harmony should be 
the responsibility of every Singaporean.”

Mr. Lim Kiang Wee, teacher,
Anderson Secondary School

“Respect is a key aspect of Racial Harmony. 
Respect hails from a good understanding 
and appreciation of cultures beyond that of 
individual ethnicities. A core value for many 

schools, including Xingnan, respect for unique ethnic practices can be inculcated 
through celebrations of ethnic festivals, holistic character education programmes 
and a myriad of related activities.  By creating a positive awareness in our young, 
they will be able to celebrate this harmony as they grow to become 21st century 
ready learners.”

Ms. Ng Big Huey, teacher, Xingnan Primary School

“To me, Racial Harmony means people of the four main ethnic 
groups-Chinese, Malays, Indians and Eurasians coming to 
live together without any conflicts, but with tolerance and 
understanding, and getting along harmoniously with one 
another. It also means each ethnic group is prepared to learn 
about other racial groups’ 
cultures and religions so 
that each group will get 

to know the others better. This will essentially 
promote peace, cohesiveness and prosperity in a 
multi-racial community like Singapore.”

Mrs. Pansy Ong, teacher, Xinmin Primary School
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Besta All-Pass 1 
Have you ever forgotten the strokes of a 
Chinese word during examination?  Fret not, 
here comes the saviour in the examination 
hall. Approved by Singapore Examination and 
Assessment Board, this e-dictionary is specially 
allowed to be brought into examination hall. 
Equipped with 2,000 characters from character 
list for Primary and Secondary schools in 
Singapore, it is definite must have for all 
students.

Specifications:
• Built-in with Contemporary Chinese 

Dictionary
• Special hot key to show writing sequence 

of Chinese word
• Automatic phrase selection and phrase 

searching 

From: www.iknow.com.sg
Price: $39.90

There is still a month to go for you to grab the best deals 
before the Great Singapore Sale ends. Wait no more. 
Come get the deals now!

By Christine Yee

Bone iPhone Driver  
This cute little USB drive supports both iPhone 
and Windows operating system. With its special 
design, you will never worry about losing its 
cover. The skin of this driver is anti-dust and 
washable and comes with lifetime warranty.  
Available in 2GB or 4GB with the selection of 
black or white.  

From: www.fruitshop.com.tw
Price: not available

Samsung MP3 Player  
The Samsung U5 MP3 player is designed with 
the active music enthusiast in mind, and can 
be tailored to suit the user’s various lifestyle 
activities. 

Simple yet stylish, it has the “Fitness Mode” 
which makes it an ideal companion for any 
physical activities. With functions such as Time 
Setting, Audio Feedback and calories calculation 
for the user’s workout regime, users can 
personalise it to suit their activities.  

The Samsung U5 MP3 Player is available in five 
colours, with 2GB or 4GB storage capacities.

From: Samsung Flagship Store @ VivoCity
Price: $29.90
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DV V502 Camcorder 
This camcorder is a multi function 5-in-1 device: digital camcorder, 
digital still camera, voice recorder, PC camera and mass storage 
device. Lightweight and user-friendly in a very affordable price, it 
is the ideal camcorder for all occasions.

Specifications:
• 2.4” TFT display
• High quality 270°swivel-reversible 
• Up to 12 megapixels still pictures 

From: www.iknow.com.sg
Price: $99.00

SonicGear 2Go WoW! 
Immerse yourself in the world of music with the WoW! 
portable speaker that turns Mono to Stereo with supreme 
clarity. Fitted with a clip for easy mounting on notebooks, 
LCD and portable devices, this lightweight speaker is 
a convenient companion. In addition, this smart gadget 
enables its main speaker to deliver stereo sound when used 
separately. WoW supports all types of audio sources.

From: SoniceGear authorised resellers
Price: $69.90 Creative EP-630 

Inspired by the ocean, the new Creative EP-
630 colour series comes in Pacific Blue, Atlantic 
Green, Mediterranean Red, Arctic White and 
Pearl White. Specially designed to deliver 
optimum performance for all music genres, the 
earphones offer high quality audio reproduction 
with extraordinary bass. Complete with the 
gold-plated 1.2m Oxygen-Free Copper cable 
that provides uninterrupted transmission of 
music from player to earphone, and soft silicone 
in-ear buds that allow users to enjoy music in 
greater clarity with amazing noise-isolation, this 
earphone is the ideal accessory.

From: sg.store.creative.com
Price: $45.00

iKnow 15



AIPTEK, Taiwan’s leading and long 
awaited manufacturer of palm-sized 
camcorders and pico projectors, 

has finally arrived in Singapore! As the 
authorised distributor of AIPTEK, @iKnow is 
proud to officially launch AIPTEK products 
in all our channels via counters, showrooms, 
online stores and AXS stations.

With PocketDV, the process of turning life’s 
precious moments into memories has become 
more convenient and affordable. Not only 
are the camcorders stylishly designed, these 
sleek and palm-sized darlings also go easy on 
your pocket.

That’s not all. Fancy a portable cinema in 
your pocket? The world’s 1st pocket-size 
multiplayer projector, Pocket Cinema V10, 
is connectable to video consoles, camcorders 
and hand phones and projects image sizes up 
to 50”.

PocketDV AHD H5 Extreme+  
• Full HD (1920 x 1080) video resolution 

up to 30fps
• Up to 60fps in WVGA mode
• 5x optical zoom lens with auto-focus, 

1cm Macro
• Built-in Youtube upload & iPod playback 

features

PocketDV AHD-1 Pro  
• HD 1440x1080 video 

resolution up to 30fps
• Support 1280x720 video 

resolution up to 60fps 
• 5x optical zoom lens and 

EIS (Electronic Image 
Stabilization), 1cm Macro

• Built-in Youtube upload option

PocketDV AHD C100  
• HD 1280 x 720 video resolution up to 

30fps
• Up to 60fps in VGA mode 
• Digital Stabiliser for clear video shooting
• Up to 16 megapixels still captures

Pocket Cinema V10  
• 640 x 480 pixels (VGA)
• Supports ASF, AVI, MPEG-4 

videos and JPEG images
• Built-in two speakers
• Weight 100g (without battery)

From: iKnow showrooms, counters (POPULAR Bookstore, Times, Carrefour, C.K. 
Tangs) & FACTORY DIRECT @iKnow (AXS Stations)
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Release Date: 9 Jul 09
Cinema: Golden Village

20th Century Boys, the bestselling comic 
series with over 250 million-plus copies sold 
to date, iis coming to you, like it’s never 
been seen before. 

With a 6-billion-yen budget and a 
star-studded cast numbering 300, 
this production, is set to deliver the 
expectations of fans worldwide. Building 
on the success of Chapter 1, 20th Century 
Boys 2 returns to continue the unfinished 
story.

Chapter 2 starts in 2015 in the dystopia 
ruled by Friend, 15 years after the Bloody 
New Years Eve. The citizens are led to 
believe that Kenji Endo and his friends 
are the satanic terrorists behind the 
horrific attempt to end humanity using 
deadly viruses. Friend, on the other hand, 
is worshipped as the saviour who stopped 
the doomsday plan. Friend now spreads the 
oracle that the end is coming and salvation 

will only come to those who believe and stay 
with him. 

Kanna, Kenji’s niece is now in high school 
and living with her surrogate mother, Yukiji. 
Bent on defeating Friend and restoring her 
uncle’s namesake, Kanna enlists the help of 
gangsters.  Meanwhile, the surviving Secret 
Base gang - Otcho, Yukiji, Yoshitsune and 
Maruo, separated since 2000, discovers 
the shocking existence of The New Book 
of Prophecies, the sequel to The Book of 
Prophecies! 

As the gang learns more about Friend’s 
secrets, crucial events from their childhood 
begin to make sense, leading towards the 
ultimate mystery: who is Friend? 

Tell us why you want to watch 
20th Century Boys 2 and stand a 
chance to win a PAIR of tickets!
Simply email your answers to 
magazine@iknow.com.sg 
Closing date: 9 July 09

Subject Header: 
Win 20th Century Boys 2 
Tickets.
Entry submitted must include 
your full name, NRIC no., 
contact no., school (if any), and 
mailing address.

iKnow 1�



In April 09, Ministry of Education 
(MOE) has selected another eight 
schools to set up new Junior Sports 

Academies (JSAs) for nurture and 
development of potential athletes from 
primary school level. These JSAs focus 
on badminton, fencing, shooting, soccer, 
swimming, table tennis and wushu.
 
Wushu, also known as Chinese martial 
arts, is one critical aspect of the Chinese 
culture that has garnered attention from 
foreigners as an indirect result of movie 
influences. Bruce Lee, famous for his 
authentic and stunning skills, is the icon of 
Chinese martial arts. But how much do you 
know about Wushu?

In this issue, Christine @iKnow finds the 
answers from Kuen Wushu Academy.

QWhat is Wushu and how does it 
differ from Kungfu or other Chinese 

martial arts?

AThe term “Wushu” is an umbrella term 
that encompasses all forms of martial 

arts, with the pre-fix “Zhong Hua Wu Shu” 
(中华武术) to specifically mean Chinese 
martial arts. 

“Kungfu” is a term made popular in the 
West by the late Mr. Bruce Lee during a TV 
interview. He was the first Asian martial 
arts movie celebrity to be interviewed in 
English by the Western media and when 
asked what it was that he demonstrated, 

By Christine Yee
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he replied “This is Kungfu”. Henceforth, 
the term stuck and is used till this day to 
represent all forms of Chinese martial arts 
in the West. 

QIs it true that people who are born 
with certain special physique are 

better suited to mastering Wushu? Is it 
possible for everyone to learn Wushu?

ACertain physique and body types are 
better suited for competitive Wushu 

Taolu (套路) or Sanda (散打) training. 
Students with a natural ability to mimic and 
imitate will pick up and reproduce Wushu 
moves faster. 

Anyway, anyone who is physically able can 
pick up Wushu relatively fast and easily. 
Interest and passion combined with regular 
training and proper techniques taught by a 
professional trainer will make up for what is 
missing physically.

QWhat are the challenges in mastering 
Wushu?

AInitially, most students will find Wushu 
training to be physically demanding 

and will return home with sore arms and 
thighs. They will also find that Wushu moves 
require quite a bit of coordination in order 
to get them right.

The best preparation is to come to 
class armed with determination and 
perseverance. Next is to keep to a regular 
training schedule and to seek motivation 
from fellow trainees as well as trainer. 

Kuen Wushu is Singapore’s 1st and biggest Sports Wushu 
Academy. To date, they have over 10,000 students and conducted 
Wushu programmes in more than 30 schools. For more 
information on Kuen Wushu, please visit www.kuenwushu.com



Illustrated by Steven Lie      Text by Christine Yee

There are numerous possibilities for a 
slow system, ranging from complicated 
virus infections, insufficient RAM, 

overheating, to the simple issue of running 
too many programs or opening too many files. 
The problems can generally be categorised as 
either hardware or software issues.

HARDWARE ISSUES: 
RAM
Different motherboard supports different 
RAM type. Check if your RAM is compatible 
with the motherboard. Incompatibility issues 
may result in slow computer performance or 
worse situations.
Hard Disk Health
Ensure your hard disk is in good health for 

smooth processing performance. A “sick” hard 
drive usually has the tell tale signs of unusual 
loud whirring noises or the extreme opposite 
– complete silence during the computer boot 
up. Refer to the previous issue for more 
details. 
  
Bad sectors can 
also lead to system 
slowdown and 
instability. To check 
this problem, right 
click on Drive C > 
Properties > Tools, 
select “Error-
checking” option to 
inspect errors or 
damaged sectors.

It’s crawling, absolutely crawling now. Sometimes, it even hangs. Your patience is wearing thin 
and you are at your wits end. The performance is so slow that it is driving you crazy.

If the above symptoms exist on your computer, there is a high chance that it has the “Slow 
Computer Syndrome”. 
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Processor
As the processor works continuously at a rapid 
pace, it generates lots of heat. Therefore, 
if the processor fan is malfunctioning, the 
processor might overheat and result in system 
slow down and instability. Factors such as 
dust, motor failure and loose bearings can 
influence the processor fan. 

Note: One of the most commonly used freeware for 
system diagnostics is Everest. 

SOFTWARE ISSUES: 
Intruders
Some of the more common culprits are 
viruses, spywares or adware which may slow 
down the computer’s performance. The main 
sources of spyware come from internet 
cookies, freeware, shareware, or applications. 
Some software, e.g. shareware or game demo 
might load spyware into your system while you 
are installing it. 

Update the anti-virus definition files and run 
a full system scan. If you don’t have anti-virus 
or it has already expired, look on the internet 
for reputable software offering free online 
scan.

Note: Disable the auto-play function of 
removable disks because it allows virus 
or spyware to access your computer 
immediately upon completing the 
auto-run function. 

Disk Defragmentation
Closing a program doesn’t 
mean it has exited from the 
system. Most of the time, 
it spreads across sectors 
located in disparate regions 
of the disk. Therefore, 
you need to perform disk 
defragmentation regularly. 
It helps for swifter file 
retrieving and reduces 
processing time.

Note: If your disk is almost 
full, move or delete unnecessary 
files to create space before you start the 
defragmenter for smoother processing.

Background Applications
Every running program eats up RAM. Due to 
some programs having the “Run on Startup” 
option enabled, you may not even be aware 
that a dozen of applications are running 
simultaneously. 

Note: Enable “Run on Startup” option for essential 
processes only. 

Recall what the recent changes to your 
computer are, e.g. RAM upgrade, device driver 
update or new program installed, before 
you start to troubleshoot. You may consider 
reverting back to the previous condition that 
worked.

If the errors are beyond your ability to fix, 
contact the expert for professional help, and 
also to avoid any further damages.

iKnow �1



The Legend of

Sigurd and Gudrun 

This is an unpublished 
work by J.R.R. Tolkien. 
Pre-dating his works 
of “The Hobbit” and 
“The Lord of the Rings”, 
it tells the legend of a 
Norse Hero, Sigurd, 
the revenge of his wife, 
Gundrun, and The 
Fall of the Niflungs (or 
Nibelungs). Sigurd, 
the hero who killed 
the greedy dragon 
Fáfnir and gained 
the cursed treasure, 
wakened the beautiful 
Brynhild who slept 
surrounded by walls of 
flames. He promised 
to marry her when 
he has built his own 

kingdom. However, 
he fell in love with the 
beautiful Gudrun and 
married her instead, 
and then deceived 
Brynhild into marrying 
his brother-in-law, 
Gunnar. From there 
on, the story unfolds 
into a series of events 
that depicted betrayal, 
jealousy, hatred, death, 
destruction, revenge 
and tragedies.

By J. R. R. Tolkien

A Boeing 777 lands at 
JFK airport and stops 
dead halfway on the 
tarmac. All window 
shades are down, 
lights are out and 
all communication 
channels have gone 
quiet. Ground crews 
are lost for answers 
and an alert goes out 
to the CDC. 
Dr. Eph Goodweather 
gets the call and 
boards the plane. 
What he finds makes 
his blood run cold. 
Running full pace into 
a race against time, as 
a vampiric virus from 
the flight spilt out 
into the streets and 

infected New York, 
Eph must find a way 
to stop the contagion 
and save his city—a 
city that includes his 
wife and son—before 
it is too late…

The Strain
By Guillermo del Toro

NowiKnow | Books Galore
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Grand Central station, 
New York. 1:23pm.
What started as a 
normal day on the 
New York City subway 
became a race against 
time when a commuter 
train was hijacked. 
With a train full of 
passengers held to 
ransom, the NYPD 

pursues on the city 
streets while the 
underground escapade 
ensued. However one 
question remains: the 
subway is a closed 
system, is escape 
possible? But the 
hijackers had other 
plans; get the ransom 
and crash the train...

Distributed by MPH Distributors. Available at all Major Bookstores.

If you have a problem 
remembering names, 
numbers or even 
where you parked 
your car, then Tony 
Buzan can help. His 
revolutionary 7-day 
programme can 
supercharge your 
brain power and 
make your memory 
razor sharp. Start off 
by taking the brain fit 

quiz to see how you 
rank on the memory 
meter. Then - at your 
own pace - begin the 
short exercises and 
questionnaires in the 
7-day programme. In 
just one week, you’ll 
discover your memory 
noticeably sharper 
and your mind more 
agile.

Simply email to: magazine@iknow.com.sg 

Subject Head: MPH Voucher Contest
Submit your full name, NRIC no., school name (if any), contact no. and 
mailing address.

Closing date: 20/08/09

100 MPH Book Vouchers
for Grabs!

The Taking of

Pelham 123 
By John Godey

Tony Buzan’s

7-Day Brain Boost 
By Tony Buzan

NowiKnow | Books Galore
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Dolphin
Living in small groups called “pods”, 
the dolphin is a highly intelligent, 

interactive and sociable mammal. Often 
noted to accompany ships out at sea, it has 
long been documented that dolphins are 
probably man’s best friend and stories of their 
rescue acts date back to ancient Greece. From 
rescuing a drowning person to protecting 
shark-threatened victims, dolphins have also 
been known to render assistance to stranded 
whales that accidentally beached themselves 
and are unable to return to the waters. Dolphins 
communicate with one another by means 
of whistles, which double up as a form of 
identification for different dolphins.

Eagles
Eagles are amazing, powerful predators 
with sharp eyesight, light bodies,  soaring 

wings, dagger beaks and sharp talons to hunt 
fish, snakes, frogs, other birds, and small 
mammals. They are among the world’s largest 
birds of prey, with the largest eagles being the 
Philippine eagle and the Harpy eagle of tropical 
South America. They weigh over 9 kg and have 
a wingspan of 2 m. Using their huge talons, 
these giant birds can kill and carry off prey as 
large as monkeys.

The eagle’s eyesight 
is about four to five 
times stronger than a 
human with perfect 
vision. They can easily 
see a rabbit on the 
ground from 300 m 
up and 1 km away!

There are 59 different 
kinds of eagles on 
Earth and they live in 
every environment 
except the Polar Regions of Antarctica.

Find out more @ http://www.globio.org/
glossopedia/article.aspx?art_id=48&art_
nm=Eagles

Tips @iKnow
Find out more about dolphin’s bravery 
from
• http://www.science-frontiers.com/sf035/

sf035p09.htm
• http://today.msnbc.msn.com/id/21689083
• http://www.cbc.ca/world/story/2004/11/24/

dolphin_newzealand041124.html
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Fish
Fish is the common name for 29,000 
species of cold-blooded vertebrates that 

live in freshwater and ocean environments and 
are grouped into one of three categories:
Jawless fish – These are long snake-like fish with 
no scales. They have a suction mouth with teeth 
they use to hold on to their prey.

Cartilaginous fish – These include sharks, rays, 
and skates. Their skeletons are made of cartilage 
(not bone), specialised rows of teeth, and scales 
that look like tiny pointed teeth.

Bony fish - Most of the world’s fish species are 
bony fish. Bony fish like goldfish, tuna, tilapia, 
and salmon have long tapered bodies that are 
excellent for powerful swimming.

Find out more @ http://www.globio.org/
glossopedia/article.aspx?art_id=27&art_
nm=Fishes

Where Kids Discover 
the World
Founded by Gerry 
Ellis, GLOBIO is a 
non-profit, children’s 
educational 
organisation. It 
creates the world’s 
first safe children 

global online community and the resource 
is designed for kids to learn, share and get 
involved with other kids from around the 
world. 

Changing Education 
with Your Support
Your generous 
contribution 
delivers learning 
opportunities to 
over 50,000 kids 
around the world. 
Please donate now! 

Alternatively, please support GLOBIO’s new 
projects through wonderful puppets on sale. 
Own them and discover their virtual habits. 
Log on to www.globio.org to buy now!

Image by Robodot
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This month I turn the spotlight on Multiuser 
Virtual Environments (MUVEs). Examples 
of MUVEs include Second Life™ and 

Quest Atlantis. At present there are about 70 
to 80 MUVEs worldwide, with Second Life (SL) 
being the best-known of all. 

SL is a virtual world established by Linden Labs 
in 2003 (http://www.secondlife.com).  SL allows 
people to meet, interact and co-create without 
being physically present in the same place. 
Participants represent themselves by means of 
avatars. The image below shows an avatar in SL 
performing on stage while other avatars in the 
audience watch on.

Gartner predicted that by 2011, about 80% 
of active online users will have avatars. That 

could mean that having an avatar might be 
as common as having an email or Facebook 
account!

What does SL offer that other online 
environments do not? You can do anything in SL 
that you can do in real life. You can walk and 
run and you can interact with other avatars via 
text messaging, 
body language 
(gesturing) or 
voice. You can 
go shopping at 
virtual malls or 
visit places of 
interest. 

By Dr. Ashley Tan

FeatureStory
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Dr. Ashley Tan is an Assistant Professor in 
the Learning Sciences and Technologies 
Academic Group. His interests include the 
educational applications of various Web �.0 

tools, Second Life and video games. As 
a teacher educator, he facilitates 
a core course, ICT for Engaged 
Learning, for teacher trainees. 

Profile:

You can also do 
some things that are 
too dangerous or 
impossible to do in 
real life under water 
without drowning, 
fly like Superman, 
or teleport from one 
place to another. 
Not only can you 
change your clothes 
in SL, you can also 

change your physical appearance and even 
your gender!

 
SL allows users to collaborate with anyone at 
anytime, from any part of the real world. While 
Linden provides the space and land, it is up to 
users to create everything that you see in SL: 
Buildings, furniture, rocks, plants, animals, etc.
SL is not a game. Unlike most games, SL does 
not have levels, quests or goals for users to 
achieve. It is up to users to decide what they 
want to do in SL. If users decide to create 
a game-like environment complete with 
challenges, it is entirely up to them.

If you are thinking of exploring SL, note that 
it has two “grids”. The first is the Teen grid for 
ages between 13 and 17, and the second, an 
Adult grid for ages 18 and above. The grids are 
fully independent and you cannot interact with 
someone from the other. Those below the age 
of 13 might try something like Quest Atlantis 
instead.

SL is free to access. However, if you wish to 
own land, create objects or elaborately change 
your appearance, you will first need to use a 
credit card to purchase Linden dollars (L$). L$ 
is the currency which allows people to buy 
and sell objects in SL. At the moment, L$170 is 
worth about S$1.

Since SL’s establishment, various companies 
and people have set up businesses in SL to 
publicise what they do and/or to sell products 
ranging from clothes to real estate. Some have 
been very successful. In November 2006, 
Business Week featured Ansche Chung, a SL 
millionaire (in equivalent US$).

The incorporation of SL in education is 
relatively new. Below are some resources on 
the educational benefits of SL. 

Antonacci, D.M. & Modress, N. (2008). 
Envisioning the Educational Possibilities of 
User-Created Virtual Worlds. AACE Journal, 
16(2), 115-126.

Prezi presentation on Second Life
http://prezi.com/10156/

Seven things you should know about Second 
Life
http://www.educause.edu/ELI/
7ThingsYouShouldKnowAboutSecon/163004

YouTube videos
• http://www.youtube.com/
watch?v=TMGR9q43dag
• http://www.youtube.com/
watch?v=qOFU9oUF2HA

FeatureStory
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Microsoft
PowerPoint Series

By Christine Yee

In the previous issue, we discussed how to 
create a moving animation using the motion-
path feature. Motion-path is a very useful tool 

to create flash-like effect on PowerPoint. If you’re 
unable to find a suitable animation clip for your 
presentation, this article may just be your saviour!

Objective: To create a bouncing object  

Positioning the Object

a. Draw an object or insert 
a picture at the starting 
point. Right click and 
choose “Format Shape” 
to change colour, 
including outline.

b. If you wish to have the 
object bouncing into the 
slide, drag and position 
outside the slide.  

Motion-path of the Object

a. Decide on a motion path for the object.
b. Select the object, click Slide Show > Custom 

Animation > Add Effect > Motion Paths > Draw 
Custom Path > Curve.

c. Draw your desired curve, starting from the 
middle of the object to the estimated landing 
point. 

d. Preview the animation effect by clicking play.
e. Adjust the landing point if necessary.

Change of Size
a. If your object needs 

to have the 
“squashed” 
effect when it 
bounces, select 
the object and 
(under “Custom 
Animation”) 
click Add Effect > 
Emphasis > Grow/ 
Shrink. Alternatively, 

Do you know that Microsoft 
PowerPoint allows users 

to generate fascinating 
animation but with little fuss?

Do you know that Microsoft 
PowerPoint allows users 

to generate fascinating 
animation but with little fuss?

Educators’Tips
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select “More Effects” to view the full list for 
“Grow/Shrink” effect.

b. Select “Vertical” from the “Size” drop-down 
box on the right side of the slide. Enter “80%” 
under “Custom”.

c. Set to “With Previous” from the “Start” drop-
down box.

Size Recovery
a. To get your object back 

to its original size, 
select the object, click 
Add Effect > Emphasis 
> Grow/ Shrink.

b. Choose “After Previous” 
from the “Start” drop-
down box.

c.  Enter “125%” in the 
“Custom” text box 
from “Size” drop-down 
box. 

Subsequent Motion-
Path of the Object
a. For subsequent 

bounces, click Add 
Effect > Motion Path > 
Curve.

b. Draw a curve line for 
the object. The impact 
of the bounce depends 
on the depth of the 
curve.  Due to energy 
lost when the object 
bounces, the height of 
the curve should become smaller. 

Finally, click “Play” button to review all animation 
effects. The speed of the two motion-paths should 
be adjusted to “Fast” and two “Grow/Shrink” 
effects to “Very Fast” for a more realistic effect.

Having IT problems? Want to share 
your find outs with others? Send an 
email to magazine@iknow.com.sg 
today! Subject: Educators’ Tips.

PowerPoint questions:

QI use quite a number of drawing and 
symbol commands while I’m doing 

presentation slides. It is a hassle to keep 
clicking the menu bar to select the tools! 

ATo save time and trouble, personalise 
a toolbar with all your frequently used 

commands. To create your own toolbar: 
Tools > Customise > Toolbar > New. After 
you’ve entered a name for the new toolbar, 
click on the commands tab to select the 
desired buttons and drag them to your new 
toolbar.

Tips @iKnow

To control the speed more precisely, right 
click on the effect and select “Timing”. 
Alternatively, set a slower timing in the 
“Delay” box.

Educators’Tips
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Everyone breathes differently under 
different situations. But do you know that 
the way we breathe reflects our state of 

mind and vice versa? 

Experts agree that shallow breathing is often 
associated with anxiety, high blood pressure 
and other psychosomatic disorders. An 
important task of growing up is learning to 
manage our state of mind and emotions. 

Growing children face new challenges everyday 
and challenge itself can provoke stress. 
Children who lack tools for managing stress 
may avoid challenges and thus compromise 
what they can achieve.  

Hence, breath work and breath therapies have 
become the physical fitness for the children 
of next millennium after the past decades. The 
‘60s taught us that moving our bodies make us 
feel better. The last two decades have brought 
about a revolution in the way we think about 
our diets and nutrition. But if our bodies are not 
taking in and using oxygen effectively, then our 
health is not complete.

This issue will share with readers a simple 
technique to improve breathing.

Simple Diaphragmic Breathing
(3yrs onwards)
1. Sit down with your children and explain that 

everyone in the family is going to learn a 
new type of breathing called “diaphragmic 

By Miss Has
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“Children can learn to use their breath as a tool to safely integrate their 
feelings and emotions, increase their skill levels and stay mentally 
focused.”

By Caron B. Goode, Ed.D.
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Profile:
Has AR, more 
affectionately known 
as Miss Has is 
the Founder and 
Creative Director 
of Positive Focus 
Pte Ltd. Has has 
been working with 
parents and their 
children since 1���. 
She also conducts classes in schools and 
private institutions around Singapore. 

Has has gained the following qualifications:
- Certified Master NLP (Neuro-Linguistic 

Programming) Practitioner
- Time Line Therapy ® Practitioner
- High Impact Learning, brain-based 

teaching for accelerated learning
- YogaKids International Trainer
- Kindermusik Professional Development 

Certificate

breathing”. This is a more calming type of 
breathing compared to shallow breathing.

2. Ask them to take a few slow, deep breaths 
and allow their tummy to push out as air 
fill their lungs, and bring their tummy back 
gradually like a deflating balloon as they 
exhale. 

3. As soon as their breathing is slowed and 
diaphragmic, invite them to breathe in a little 
bit deeper; lift one finger at a time as you 
breathe in 5 counts and close one finger at a 
time as you breathe out 5 counts.

In the next issue, @iKnow Magazine will 
be introducing another two more breathing 
techniques to provide more options in breath 
work. Stay tuned!
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Besta MT 7000
Sleek in design and filled with user-friendly 
features, the ultra-mobile Besta MT 7000 is the 
perfect companion to master Mandarin without 
hassle. Equipped with interactive self-learning 
modules, learning Mandarin has never been 
easier!
Specifications:
• 4.3” touch screen 
• English & Chinese talking dictionary with two-

way sentence translation
• Exclusive built-in “Pronunciation Correction”
• Self-learning modules: comprehensive essay 

writing guide & learn Mandarin in English

From: FACTORY DIRECT @iKnow (AXS Station, under Lifestyle category)

This Great Singapore Sale, @
iKnow is pleased to introduce the 
hot deals of all our channels to 
you!  

By Christine Yee

Besta CD-356S
Equipped with the latest version of the reputable “Oxford Advanced Learner’s English-Chinese 
Dictionary” that provides bilingual explanations and sample sentences, Besta CD-356S is definitely 
the smart choice for e-dictionaries. It also contains Bahasa Indonesia Dictionaries and “Singapore 
Vocabulary Dictionary” to facilitate the language learning process.
Specifications:
• Built-in bilingual version of “Contemporary Chinese Dictionary” 
• Built-in “Britannica Concise Encyclopedia” with English and Chinese comparisons

From: www.iknow.com.sg

ProductsFeatures
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AIPTEK PocketDV H200 HD
Enjoy the capability to capture beautiful moments easily and affordably. This palm-sized camcorder 
comes with a simple and decent design and user-friendly features. If you’re looking for a budget handy 
camcorder that you can bring along anytime and shoot instantly and clearly with no fuss, AIPTEK 
PocketDV H200 is the choice. High-definition shooting has never been simpler than this.
Specifications:
• 1280 x 720 pixels high-definition resolution up to 30fps
• Reversible 2.4” high quality LCD display
• Still image capture up to 16 megapixels

From: All iKnow counters & showrooms

Aspire One D250
At a little more than a kg, Aspire One D250 provides 
style and compact features combined with ultra-
portability. It also comes with a multi-touch gesture 
touchpad that allows you to rotate, flip and zoom 
via simple movements. With up to 7.5 hours of 
battery life and selection of four colours – black, red, 
blue and white, it is the ideal personal gadget for 
everyone.
Specifications:
• Intel Atom N280 1.66GHz
• Glossy 10.1” display
• 1GB DDR2 and 160GB HDD
• Windows XP Home

From: www.iknow.com.sg & selected iKnow counters

ProductsFeatures
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Carrying the glory of being the first 
independent school chosen to be a ‘Future 
School’, Hwa Chong Institution introduces 
the Nexus as the highlight for her plan of 
borderless communications and unlimited 
learning opportunities.  

With the focus on developing an all 
encompassing e-learning solution 
which addresses borderless 

communications, Nexus links up learning 
communities “live” across cultural boundaries 
and serving both independent and group 
learning.

Logging onto the HCI Nexus (HCnX) portal, 
teachers and students can access key features 
such as:

Hwa Chong Tube:-
A la-YouTube website for users to upload and 
stream educational content while promoting 
social networking.

Independent Learning System:-
This student-centered system promotes both 
self and group learning by enabling teachers 
to set the syllabus while students decide their 
personal learning paths. 

By Christine YeeBy Christine Yee
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Research and Partnership Portal:-
This community-based application allows 
mentor-mentee matching cum search facility. 
It also promotes online conferencing tool and 
real-time application sharing tool, bringing 
together users from both local and overseas,  
into Hwa Chong’s research environment.

IDM based contents are also featured. Besides 
having Chinese Games, there will also be 
interactive virtual field trips that allow students 
to experience and access locations that are not 
easily accessible in ‘real-life’.

The HCI programme seeks to empower students 
to pursue their passion through independent 
learning and collaborative explorations that 
goes beyond the boundaries of  classrooms, 
schools, countries and cultures. To support its 
vision, the Hwa Chong Nexus (HCnX) uses 
a two-pronged vision to nurture passionate 
and independent learners, and to provide a 
borderless learning environment as part of 
an integrated system designed to create a 
learning environment that supports diverse 
learning styles and a broad range of assessment 
strategies. Specifically, it caters to both 

independent and collaborative learning. The 
school vision and basic research questions are 
tied closely to the 2key components of HCnX :

1Independent Learning Gateway.
Students will be able to self-study 
and gain new knowledge through the 

gateway and the usage of IDM/ICT tools. With 
a wide variety of learning content for students’ 
selection, instructional support is also readily 
available to assist students create study plans 
within the network. 

2Virtual Learning Communities (VLC) 
Portal. 
The Web 2.0-styled collaborative learning 

environment  facilitates different groups of 
students to cooperate in solving research 
problems or creating products. Students, 
together with mentors, work together on self-
directed projects and such expertise comes 
mainly from the school’s  networks of strategic 
partners and alumni. The student-mentor 
match-up and resources further enable students 
to build knowledge in both real and virtual 
platforms.

Technology connects us to people 
around the world.  We can also take 
charge of our own learning and work 
with our peers overseas, broadening 

our perspective. “
Zang Eyu 

Student 

Hwa Chong Institution

SchTalk
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“Without music,
life would be an error.”
Friedrich Nietzsche (1844-1900)

By Teresa Maria Lee, Music Coordinator, Catholic High School Primary

This year, Catholic High School will be 
staging an original musical “Best days 
of our lives” on 20th and 21st August at 

Victoria Theatre. 

2008 has proven to be a bountiful year for 
Catholic High School; not only did the school 
achieve excellent overall academic results, it 

SchTalk
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also won many prestigious awards in the arts. 
Four of the five aesthetics groups in the primary 
school have also done the school proud by 
attaining Gold with honours in the SYF 2008. 
Hence our principal, Mr. Lee Hak Boon, 
decided to appoint the Aesthetics Department 
to spearhead our talented students to perform in 
a huge musical.
 
The musical features our award-winning 
musical groups, namely the Catholic High 
Edward Becheras Choir, Chinese Orchestra, 
Concert Band, Dance and String Ensemble. 
Since early 2009, students have been practising 
intensely for the upcoming mega school event 
to bring the audience on an exhilarating music 
journey with specially composed tunes.

“Best days of our lives” showcases the essence 
of growing up years. Daily life issues such as 
handling school bullies, mounting parental 
pressure and coping with family problems are 
among the highlights. Journey through the ups 
and downs of four school boys and watch as 
they overcome adversities. 

With efforts from our music director, Ms. 
Jacqueline Peeris who composed all songs; 
scriptwriter, Mr. Rodney Oliveiro who promises 
to bring the audiences on a musical adventure; 
as well as experienced drama coach, Ms. 
Serena Ho, the young student actors have 
blossomed into a group of confident gentlemen 
ready to shine on stage.   

Catholic High School wishes to extend an 
invitation to all to come and experience this 
wonderful musical adventure. See you!

In an effort to push education boundaries and 
add further diversity to Singapore’s education 
landscape, a new specialised independent 

school - School of Science and Technology 
(SST), adopting applied learning approaches, 
will be in operation come January 2010. 

Applied learning connects classroom teachings 
to the real world. It aims to help students build 
stronger academic foundation and allows 
students to apply what they learnt to the real 
world. At the end of the programme, students 
can then enter university either via the junior 
college or polytechnic route. 

Moreover, the integrated approach combining 
different disciplines allows students to 
understand the content from multiple angles. 
It also helps students to build critical thinking 
skills through relating and applying what has 
been learnt as opposed to other approaches that 
tend to produce book-smart students. 

Do check out the musical’s website www.
cathighprimarymusical.com for more information, pictures 
and updates!

Applied Learning @ SST
By Christine Yee

Name: School of Science and Technology, Singapore 
(SST)
Admission: Direct School Admission (DSA) Exercise from 
Apr – Aug 09
Date of opening: January 2010
Highlight: offers 4-year programme that prepares 
students for GCE ‘O’ level examinations via applied 
learning.  

SchTalk
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After four months of intense competition, Boon 
Lay Secondary School’s ‘B’ and ‘C’ Boys 
Badminton Team have successfully defended 

our zone championship title for the year of 2009. 

In addition to our past years’ achievements, we 
are also the West Zone champion in the annual 
Inter-School Badminton Championships for the 4th 
consecutive year. At national level, our ‘B’ division 
boys went on to pit their skills against outstanding 
players from the North, South and East zones to 
eventually attain a third position. Though we did not 
reach the pinnacle of the competition, we gained 
valuable experience from beating strong opponents 
from ACS (Independent) School, Maris Stella High 
School and Singapore Sports School! 

Concentration was absolutely vital, especially amid 
distractions from the vociferous spectators and 

fatigue build up. We had to play above ourselves in 
every match, which can last up to half an hour! 

All these require consistent and resolute trainings 
which ensured that all our efforts do not go to waste. 

At the end of the day, I would like to thank my team 
mates who always encouraged one another when the 
going got tough. Our patient and caring teachers also 
taught us invaluable lessons on time management so 
that we can better balance our trainings and studies. 

I felt that I have matured a lot after my two and a half 
years in Boon Lay Secondary School. I will continue 
to work hard before graduation, to scale greater 
heights. 

By Zuhri, student, Boon Lay Secondary School

SchTalk
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Da Vinci – The Genius 
Direct from Italy, this world 
acclaimed exhibition brings to life 
Leonardo’s genius as an inventor, 
artist, scientist, anatomist, engineer 
and architect. It displays interactive 
and life-size machines crafted by 
Italian Artisans; anatomical sketches 
and 3D animations as well as the 
new and revealing Secrets of Mona 
Lisa exhibit from Paris. It is the most 
comprehensive exhibition ever 
assembled on the greatest mind that 
ever lived.  
Date: now till 16 Aug
Venue: Science Centre Singapore, The Annexe

The Games Xpo 2009  
With Games Exchange Alliance, as event host, together with 
the Singapore Cosplay Club and Virtualand, Singapore’s leading 
arcade games centres, as official event partners, TGX09 is 
presenting the entire spectrum of gaming industry to the next 
higher level.
Date: 3 Jul – 5 Jul
Venue: Suntec City Convention Hall 4

Night Festival 2009
Night Festival 2009 is set to dazzle over a weekend with 
live outdoor music and dance, and provides a chance to 
experience spectacular interactive light installations. With 
local acts – Bersama Hijau, spectacular opening dance, 
percussion and vocals by 80 talented performers as well 
as pyrotechnics show by Pan.Optikum from Germany, it 
is an event for the entire family not to be missed!  
Date: 10 Jul – 11 Jul
Venue: Various
Time: 7.30pm – 2.00am

tSingapore HeritageFest (SHF) 
“Celebrate Our Multicultural Heritage” and discover “Who’s Your 
Neighbour?” at the SHF. Throughout SHF, festival-goers will have the 
opportunity to participate and share the fun at events like schools’ 
competitions and outreach programmes; photography competition 
and exhibition; festival satellite hubs in the heartlands; music and food 
events; bus tours as well as outdoor challenges.   
Date: 15 Jul – 26 Jul
Venue: Various

EventsCalendar

iKnow ��





ComicCorner

iKnow �1




